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Laboratory Session - Dipole Magnet 
 
This session is divided into two parts:  (1) a hands-on measurement section where you will perform 
magnetic field measurements on a small dipole magnet and (2) a computer simulation one where you 
will use a simulation package to compare the field calculations with actual measurements. 
Depending on the schedule you have been assigned, you will either do the (1) hands-on or (2) computer 
simulations first. 
 
CAUTION! This lab requires mechanical assembly/disassembly, please be careful so you do not damage 
the coils or connections leading to possibly dangerous shorts across the coil turns.  Be careful not to over 
tighten the screws so the threads do not get stripped. 

 
 

1. Hands-on measurements 
1.1. Assemble the dipole magnet with the thick return plates and wide pole pieces 
1.2. Connect the power supply, two digital multi-meter, and magnet together to be able to measure 

the total magnet coil current and voltage.  Make sure the power supply is in current control mode 
so the current does not change as the coils heat up (voltage knob turned up to maximum, then use 
current knob to adjust current).  Make sure to connect coils in series with the power 
supply/multi-meter.  Please have an instructor check your connections before powering up the 
magnet. 

1.3. Make a sketch of the mechanical dimensions of the magnet including all pole pieces and return 
plates for use in POISSON magnet field calculations in Section 2. 

1.4. Sketch your electrical setup including magnet, coils, multi-meters and power supply.  
1.4.1. Measure the magnetic field in the center of the magnet, By=(x=0, y=0, z=0), and voltage 

across the coils as a function of current – up to 0.5 Amperes below the maximum current the 
supply can provide.  Make the measurement with both increasing and decreasing current.  
Derive the power required at each current setting. 
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1.4.1.1. Plot the magnetic field in the center of the magnet vs current and fit a line to the 
data.  Does the magnet exhibit any hysteresis in this configuration?  Derive the number 
of turns per coil from the slope of the fit. 

1.4.1.2. Plot the power required vs magnetic field.  What would the power be at each 
magnetic field point if the coils had twice the number of turns and half the copper cross 
sectional area?  Assume the magnet is not saturated. 

1.4.2. Measure the magnetic field transversely across the gap, i.e., By(x, y=0, z=0) at the highest 
current setting used in section 1.4.1.  Note: you might want to take more data points where the 
field starts to change. 

1.4.2.1. Plot the magnetic field vs position. What is the range, in mm, across the entire 
aperture where the field does not vary more than 3%? 

1.4.2.2. Fit the transverse field data to the sixth order in transverse position as measure 
from the center of the magnet.  Which fit coefficients dominate? Why?  Note: you may 
want to include field data that deviates by no more than 5-10% from the central field.   

1.4.3. Measure the magnetic field axially from far outside the magnet to the center of the magnet, 
i.e., By(x=0, y=0, z) at the highest current setting used in section 1.4.1.  Note: you should take 
more data points where the field changes rapidly to accurately map out the field. 

1.4.3.1. Plot the magnetic field vs position.  Determine the field integral for the magnet and 
the effective length for the magnet.  The effective length is calculated by an integral 
along the path taken by the beam’s center of mass as it passes through the field and then 

normalized using the peak field value:    
 

    
∫    
 

  
 

1.4.3.2. Calculate the total deflection angle for a 30 MeV electron beam passing through this 
magnet.  Make a sketch of the beam trajectory through the magnet. 

1.5. Assemble the magnet with the thin return plates and wide pole pieces. 
1.5.1. Measure the magnetic field in the center of the magnet, By=(x=0, y=0, z=0), and voltage 

across the coils as a function of current – up to 0.5 Amperes below the maximum current the 
supply can provide.  Make the measurement with both increasing and decreasing current.   

1.5.1.1. Plot the magnetic field in the center of the magnet vs current and fit a line to the 
data.  Does the magnet exhibit any hysteresis in this configuration?  Why is this data 
different than the data measured with in part 1.4.1.1? Using the number of turns/coil 
determined above, derive a value for the part of Ampere’s Law contour integral outside 
the gap as a function of current.  Why does this part of the contour integral become 
larger with current? 

1.5.2. Measure the magnetic field transversely across the gap, i.e., By(x, y=0, z=0) at the highest 
current setting used in section 1.4.1.  Note: you might want to take more data points where the 
field starts to change. 

1.5.2.1. Plot the magnetic field vs position. What is the range, in mm, across the entire 
aperture where the field does not vary more than 3%? Is this range larger or smaller 
than previous measurement, 1.4.2.1? Why? 

1.5.3. Measure the magnetic field axially from far outside the magnet to the center of the magnet, 
i.e., By(x=0, y=0, z) at the highest current setting used in section 1.4.1.  Note: you should take 
more data points where the field changes rapidly to accurately map out the field. 

1.5.3.1. Plot the magnetic field vs position.  Determine the field integral for the magnet and 
the effective length for the magnet.  Are the field integral and effective length larger or 
smaller than those found in part 1.4.3.1. 

1.6. Assemble the magnet with the thick return plates and narrow pole pieces. 
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1.6.1. Measure the magnetic field in the center of the magnet, By=(x=0, y=0, z=0), and voltage 
across the coils as a function of current – up to 0.5 Amperes below the maximum current the 
supply can provide.  Make the measurement with both increasing and decreasing current.  

1.6.1.1. Plot the magnetic field in the center of the magnet vs current and fit a line to the 
data.  Does the magnet exhibit any hysteresis in this configuration?  Do you get the same 
slope as section 1.4.1.1? Why or why not? 

1.6.2.  Measure the magnetic field transversely across the gap, i.e., By(x, y=0, z=0) at the highest 
current setting used in section 1.4.1.  Note: you might want to take more data points where the 
field starts to change. 

1.6.2.1. Plot the magnetic field vs position. What is the range, in mm, across the entire 
aperture where the field does not vary more than 3%? Is this range larger or smaller 
than previous measurement, 1.4.2.1? What determines the good field range? 

1.6.2.2. Fit the transverse field data to the sixth order in transverse position as measure 
from the center of the magnet.  Which fit coefficients dominate? Why?  Compare to 
coefficients from section 1.4.2.2. Note: you may want to include field data that deviates by 
no more than 5-10% from the central field.   
 

2. Magnetic Field Calculations for a Dipole Magnet Using POISSON 
POISSON is a computer program used to simulate magnetic fields.  Please reference “Using POISSON” 
at the end of this document for help.   
2.1. Start with an input file for a magnet of the same type and modify the geometry as desired.   

2.1.1. If you have not completed the hands-on portion of this lab, go to see the lab group with that 
assignment and measure the relevant dimensions, including pole pieces and return plates.  

2.1.2. Calculate the dipole magnetic field at a coil current of 0.5 Amperes less than the maximum 
supply output.  Do this for the thin/wide, thick/narrow, and thick/wide return flux plates and 
pole width combinations, respectively. 

2.1.2.1. Print out the results and compare with the central field and transverse field By(x, 
y=0, z=0) distributions from measurement data.   

2.1.3.  For the thick/wide and thin/wide return/pole pieces, measure the central field as a 
function of increasing current (0<I<10 Amperes).  Plot the field vs current.  Determine the 
saturation-where the field no longer increases linearly with current.  As you increase the 
current, note the field in the iron where the field contours are most dense.  These are the 
regions where saturation will occur first.  If the saturation becomes too large the program 
might not converge anymore.  Where in the magnet does the most severe saturation occur? 
Why? Do you have any suggestions to improve the magnet design? 

2.1.4. Can you figure out a way to model the longitudinal field distribution, By(x=0, y=0, z) ? Hint: 
look at the magnet at 90 degrees with respect to the beam axis and put the return yoke at 
about 10x gap apertures to the left from the magnet. 
 

3. Using POISSON for Magnet Simulation 

 
Thanks to Michael Borland of Argonne National Laboratory who provided these guidelines for a previous 
USPAS. 

 
The PC computer program (POISSON) is available to simulate magnetic fields. The program is largely self-
guiding, but we’ve included some tips in this section. 
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POISSON is actually part of a suite of programs that includes programs for magnetic, electrostatic, and RF 
field calculations. The suite is maintained by the Los Alamos Accelerator Code Group and available (for 
Windows-based PCs only) from their web site. 
The programs that you’ll use in this part are 

 AUTOMESH: the purpose of automesh is to take input giving the profiles of the iron, air, and coil 
regions of the problem, and generate a mesh that matches the problem. AUTOMESH uses an 
adaptive triangular mesh that is well-suited to magnets with curved boundaries. 

 
 POISSON: this program performs the actual magnetic field computations, using data generated 
by AUTOMESH. 
 
 WSFPLOT: this program plots problem geometry from AUTOMESH, along with field lines and 
arrows from POISSON. 
 
 SF7: this program extracts data from the field map generated by POISSON and saves it in a form 
that can be easily plotted with TBLPLOT. 

 
 TBLPLOT: this program makes line plots of data extracted from the POISSON output by SFO. It 

also allows saving the data in ASCII form, which can be imported into a EXCEL worksheet. 
 

Here are step-by-step instructions for using these programs: 
1. Find an input file for a magnet of the same type (e.g., dipole or quadrupole) that you want to 
simulate. You will find a selection of input files in subdirectories of 
c:\LANL\Examples\Magnetostatic. Do not modify the files here! Rather, copy them to your own 
area before you begin work. The files you start with are “Automesh Input” files, with file extension 
.AM. To be concrete, lets assume this file is called INPUT.AM. 
Note: We have made some additional examples of our own, namely, HFull.am and EHQuadrupole.am. 
You may wish to start with these examples as they are simpler and closer to the problems you are 
doing. These are in the c:LANL/Examples/USPAS 2012 directory. 

 
2. Before setting up your own problem, you should run the input file without modification to get 
some experience. To start, simply double-click on the file to run AUTOMESH. A window will pop 
up that will show the status of AUTOMESH as it runs. 
 
3. Once AUTOMESH completes (the window disappears), you’ll find a new file called INPUT.T35. 
Double-click on this file to runWSFPLOT and show the magnet profile. You’ll also see the mesh. 
When you are finished looking at this, close the window. 

 
4. Right-click on INPUT.T35 and select “Run Poisson.” Again, a window will pop up showing the 
progress of the program. Watch the convergence numbers. They’ll (generally) decrease 
monotonically until they are below 10−6, at which point POISSON terminates. 

 
5. Once POISSON completes, double-click on INPUT.T35 (which now contains the POISSON 
solution). WSFPLOT will again pop up a plot of the magnet profile, along with field contours and 
the mesh. You can turn on and off the various elements of the plot using the “View” menu. Moving 
the mouse around on the plot allows you to determine the field at any point in the magnet. 
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6. To see a text printout of the POISSON results, look for the file OUTPOI.TXT. To read it, right-click 
and select Edit. In the “old days,” this was all you’d get from POISSON. These days, you don’t need 
it for much except harmonic analysis. The harmonic analysis tables appear at the very end of the 
file. 

 
7. To plot field data vs x or y, you need to extract data from the INPUT.T35 file another form. Start 
by right-clicking on INPUT.T35 and selecting “Interpolate.” A dialog box will pop up. Note the four 
entry boxes in the center. You can use these to enter the x and y coordinates of the start and end of 
a line along which you want the fields. Warning: the default values give a line extending from the 
lower-left and to the 
upper-right corner of the problem, which is not really very useful. Usually, you can get what you 
want by just setting both y coordinates to zero. 

 
8. After completing this dialog, another file with a name like INPUT01.TBL will appear. Double-
click on this file to run TBLPLOT, which will plot the selected data. You can use the “Select X and Y” 
submenu under the “Data” menu to change which data is plotted. You can also use the “Save Data” 
submenu of the “File” menu to write the data to an ASCII file; the name of this file is chosen 
automatically, and is typically something like INPUT0100.TXT. 

 
Now that you are familiar with POISSON, you should copy INPUT.AM and modify it to reflect your 

problem. To do this, copy the file and right-click on the copy. Choose “Edit” to edit the file, then go 
through the steps above. Note that units for x and y are centimeters, while units for current are ampere-
turns. 
 
Some common problems using POISSON: 

1. AUTOMESH doesn’t complete successfully. Usually this means that you have an error in your 
input. Occasionally, it means that your problem is too complex and AUTOMESH is having trouble. 
Check for things like: 

(a) Two points in a row with the same coordinates. 
(b) Mesh spacing (DX and DY) too large. 
(c) Region boundary not closed. The first and last points of a region should be identical. 
(d) Line regions (XREG1, YREG1, etc) that are close to but not exactly corresponding to a 
problem feature. Line regions (which determine where AUTOMESH changes the mesh 
spacing) should either coincide exactly with problem features (e.g., a line or corner) or else 
be in a location with no problem features. 
 

2. POISSON runs for a long time and doesn’t converge. The magnet is probably very saturated. You 
may have entered an unreasonably high current. 

 
3. The field doesn’t agree with what’s expected. Did you enter the source current instead of the 
total current in ampere-turns? 

 
4. There is documentation available on the computer. To find it, go to LANL/Docs and double-click 
on SFCODES.DOC. 

 


